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ĐÁNH GIÁ HỌC PHẦN

• Điểm đánh giá của GV: 10%
• Kiểm tra: 30%
• Thi kết thúc học phần: 60%
(Điều kiện được tham dự thi: Điểm đánh giá của GV từ 
5 điểm trở lên và Điểm kiểm tra từ 3 điểm trở lên)

THI KẾT THÚC HỌC PHẦN

Thời gian làm bài: 90 phút (SV được sử dụng tài liệu)

I. PHẦN TRẮC NGHIỆM (10 câu x 0,4 = 4 điểm)
(Lựa chọn 1 phương án trả lời đúng nhất)
Lý thuyết + Bài tập
II. PHẦN TỰ LUẬN (6 điểm)
Bài tập 1: Dựa vào kết quả phần mềm SPSS (3 điểm)
Bài tập 2: Tự tính toán (3 điểm)
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I

ĐỐI TƯỢNG 
NGHIÊN CỨU 

CỦA 
THỐNG KÊ

II

CÁC KHÁI NIỆM 
THƯỜNG DÙNG 

TRONG 
THỐNG KÊ

III

THANG ĐO 
TRONG 

THỐNG KÊ

CHƯƠNG I: GIỚI THIỆU CHUNG 
VỀ THỐNG KÊ

IV

QUÁ TRÌNH 
NGHIÊN CỨU
THỐNG KÊ

Thống kê là gì?

Sơ lược lịch sử phát triển thống kê

Đối tượng nghiên cứu của thống kê

I. Đối tượng nghiên cứu của thống kê
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1. Thống kê là gì?

Thống kê học là khoa học nghiên cứu hệ thống các
phương pháp thu thập, xử lý và phân tích các con số
(mặt lượng) nhằm để tìm hiểu bản chất và tính quy
luật vốn có của chúng (mặt chất).

2. Sơ lược về sự ra đời và phát triển của 
thống kê

công cụ
quản lý 
vĩ mô

Thể hiện 
quan hệ lượng chất

Phân tích đánh giá 
theo thời gian, không giain

Ghi chép các con số
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3. Đối tượng nghiên cứu của thống kê

Mặt lượng

Mặt chất
Thời gian

Không gian

Hiện tượng và 
quá trình KTXH

Số lớn

II. Một số khái niệm thường dùng trong
thống kê

1 Tổng thể thống kê và đơn vị tổng thể

2 Tiêu thức thống kê

3 Chỉ tiêu thống kê
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1. Tổng thể thống kê và đơn vị tổng thể

Tổng thể thống kê là hiện tượng số lớn bao gồm các

đơn vị hoặc phần tử cần quan sát và phân tích mặt

lượng. Các đơn vị hoặc phần tử này được gọi là đơn

vị tổng thể.

Các loại tổng thể thống kê

Tổng thể
tiềm ẩn

Tổng thể
bộc lộ

Theo sự nhận
biết các đơn vị
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Các loại tổng thể thống kê

Tổng thể
không

đồng chất

Tổng thể
đồng chất

Theo mục đích
nghiên cứu

Các loại tổng thể thống kê

Tổng thể
bộ phận

Tổng thể
chung

Theo phạm vi 
nghiên cứu
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2. Tiêu thức thống kê

Tiêu thức thống kê là đặc điểm của đơn vị tổng thể 

được chọn ra để nghiên cứu tuỳ theo mục đích nghiên 

cứu khác nhau. 

Tiêu thức
thống kê

T
iêu

th
ứ

c
kh

ô
n

g
g

ian

Các loại tiêu thức thống kê
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Tiêu thức thực thể

Nêu lên bản chất của 
đơn vị tổng thể 

Tiêu thức
Số lượng

Biểu hiện trực tiếp
thông qua con số

(lượng biến)

Tiêu thức
thuộc tính

Biểu hiện không
trực tiếp bằng con 
số, mà bằng các

đặc điểm, tính chất
khác nhau

Tiêu thức
Thay phiên

Là tiêu thức có hai
biểu hiện không
trùng nhau trên
cùng một đơn vị

tổng thể

Tiêu thức thời gian

Phản ánh thời gian của hiện
tượng nghiên cứu
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Tiêu thức không gian

Nêu lên phạm vi lãnh thổ của
hiện tượng nghiên cứu

3. Chỉ tiêu thống kê

Chỉ tiêu thống kê phản ánh mặt lượng gắn với chất của
các hiện tượng trong điều kiện thời gian và địa điểm cụ
thể. 
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Các loại chỉ tiêu thống kê

Chỉ tiêu
giá trị

Chỉ tiêu
hiện vật

Theo hình
thức biểu hiện

Các loại chỉ tiêu thống kê

Chỉ tiêu
tương đối

Chỉ tiêu
tuyệt đối

Theo tính chất
biểu hiện
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Các loại chỉ tiêu thống kê

Chỉ tiêu
thời kỳ

Chỉ tiêu
thời điểm

Theo đặc điểm
thời gian

Các loại chỉ tiêu thống kê

Chỉ tiêu
Số lượng

(khối lượng)

Chỉ tiêu
chất lượng

Theo nội dung 
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3. Thang đo khoảng

2. Thang đo thứ bậc

1. Thang đo định danh

III. THANG ĐO TRONG THỐNG KÊ

4. Thang đo tỷ lệ

THANG ĐO TỶ LỆ
(Ratio Scale)

THANG ĐO KHOẢNG
(Interval Scale)

THANG ĐO THỨ BẬC
(Ordinal Scale)

THANG ĐO ĐỊNH DANH
(Nominal Scale)

Có gốc 0

Có khoảng cách
bằng nhau

Biểu hiệu có 
thứ tự hơn kém

MÔ HÌNH MÔ TẢ CÁC THANG ĐO

Đánh số các biểu hiện
cùng loại của tiêu thức

Tiêu thức
thuộc tính

Tiêu thức
Số lượng
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PHÂN TÍCH VÀ DỰ ĐOÁN 

THỐNG KÊ

(Phân tích dữ liệu)

TỔNG HỢP THỐNG KÊ

(Xử lý tài liệu)
ĐIỀU TRA THỐNG KÊ

(Thu thập thông tin)

VI. S¬ ®å chung cña qu¸ trình nghiªn cøu

Trình bày kết quả nghiên cứu

Xây dựng hệ thống 

chỉ tiêu thống kê 

(Xác định nhu cầu thông tin)

- Xác định mục đích nghiên cứu 

- Phân tích đặc điểm hiện tượng

ỨNG DỤNG SPSS 
TRONG QUẢN LÝ VÀ XỬ LÝ 

DỮ LIỆU THỐNG KÊ 
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1. Giới thiệu chung về SPSS

SPSS (Statistical Package for Social Sciences) Là
phần mềm chuyên dụng xử lý thông tin sơ cấp.
(thông tin được thu thập trực tiếp từ đối tượng
nghiên cứu thông qua bảng hỏi được thiết kế sẵn)

29

Các màn hình chính trong SPSS

- Màn hình quản lý dữ liệu

- Màn hình quản lý biến

- Màn hình hiển thị kết quả

30
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File: tạo file mới, mở file sẵn có, ghi file, in, thoát,…

Edit: undo, cắt, dán, tìm kiếm thay thế, xác lập các mặc định,…

View: hiện dòng trạng thái, thanh công cụ, chọn font chữ,…

Data: các vấn đề liên quan đến dữ liệu,… 

Transform: chuyển đổi dữ liệu, tính toán, mã hóa lại các biến,…

Analyze: các phân tích thống kê,…

Graphs: biểu đồ và đồ thị,…

Utilities: thông tin về các biến và file,…

Window: sắp xếp và di chuyển các cửa sổ làm việc

Help: trợ giúp

Các menu chính

31

2. Quản lý dữ liệu

Cơ sở dữ liệu (định nghĩa kiểu kĩ thuật): là một tập hợp 
thông tin có cấu trúc. 

Chú ý: Trong SPSS tại một thời điểm, chỉ có 1 CSDL 
được mở.

Thành phần của CSDL

• Quan sát (Observation): chứa thông tin về 1
đối tượng điều tra:

• Biến (variable): thể hiện các thuộc tính của
quan sát

32
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Variable Name (tên biến)

Variable Type (Kiểu biến)

Labels (nhãn biến)
Value (giá trị của từng mã hoá)
Missing (giá trị khuyết)
Measure (thang đo)

Width (Xác định số lượng ký tự hiện thị)

Decimals (số lượng số hiện thị sau dấu phẩy)

Column format (Định kích cỡ cho cột- độ rộng của cột)

Align (Định ra vị trí hiện thị các giá trị - căn phải/trái/giữa)

Khai báo biến trong SPSS

33
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I

ĐIỀU TRA 
THỐNG KÊ 

II

BÁO CÁO 
THỐNG KÊ 

ĐỊNH KỲ

III

KHAI THÁC 
DỮ LIỆU HỒ SƠ 

HÀNH CHÍNH

CHƯƠNG II: THU THẬP DỮ LIỆU THỐNG KÊ

I. ĐIỀU TRA THỐNG KÊ

Khái niệm chung về điều tra thống kê1

Phân loại2

Phương án điều tra thống kê3

Sai số trong điều tra thống kê 4

CuuDuongThanCong.com https://fb.com/tailieudientucntt

http://cuuduongthancong.com?src=pdf
https://fb.com/tailieudientucntt


1. Khái niệm điều tra thống kê

Khái niệm:

Điều tra thống kê là tổ chức một cách khoa học và
theo một kế hoạch thống nhất việc thu thập tài liệu về
các hiện tượng nghiên cứu.

Yêu cầu:
- Chính xác
- Kịp thời.
- Đầy đủ (nội dung, phạm vi).

2. Các loại điều tra thống kê

Điều tra không
thường xuyên

Điều tra thường
xuyên

Theo tính chất liên tục 
của việc ghi chép
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Điều tra 
không toàn bộ: 

chỉ tiến hành thu 
thập thông tin ở 
một số đơn vị 

thuộc đối tượng 
nghiên cứu 

Điều tra toàn bộ
Tiến hành thu 

thập thông tin ở 
tất cả các đơn vị 
thuộc đối tượng 

nghiên cứu

Theo phạm vi đối 
tượng được điều tra  

2. Các loại điều tra thống kê

Điều tra không toàn bộ

Tiến hành thu 
thập thông tin 
trên một số ít 
các đơn vị 
(thậm chí 1 đơn 
vị) nhưng đi sâu 
nghiên cứu trên 
nhiều phương 
diện

Tiến hành thu 
thập thông tin ở 
bộ phận chiếm 
tỷ trọng lớn nhất 
trong tổng thể

Điều tra 
trọng điểm

Điều tra 
chuyên đề

Điều tra 
chọn mẫu

Tiến hành thu 
thập thông tin 
trên các đơn vị 
đại diện, kết quả 
thường để suy 
rộng cho tổng 
thể
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3. PHƯƠNG ÁN ĐIỀU TRA THỐNG KÊ

Nội dung 4

Nội dung 3

Nội dung 2

Nội dung 1

Chọn phương pháp thu thập thông tin 

Xác định nội dung điều tra 

Xác định phạm vi, 
đối tượng và đơn vị điều tra 

Xác định mục 
đích nghiên cứu 

Nội dung 7

Nội dung 6

Nội dung 5

Lập kế hoạch tổ chức và tiến hành điều tra 

Chọn mẫu điều tra 

Soạn thảo bảng hỏi 

4. Sai số trong điều tra thống kê

 Sai số điều tra thống kê là chênh lệch giữa trị số thu

được qua điều tra so với trị số thực tế của hiện tượng

 Phân loại:

- Sai số do đăng ký ghi chép:

- Sai số do tính chất đại biểu (ĐTCM)
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II. BÁO CÁO THỐNG KÊ ĐỊNH KỲ

Báo cáo thống kê định kỳ: Là hình thức thu thập thông

tin định kỳ theo nội dung, phương pháp và chế độ báo

cáo chính thức do cơ quan có thẩm quyền quy định

 Các loại

- Chế độ báo cáo thống kê cấp quốc gia

- Chế độ báo cáo thống kê cấp bộ, ngành

Nội dung chế độ báo cáo thống kê

• Mục đích
• Phạm vi thống kê
• Đối tượng áp dụng
• Đơn vị báo cáo
• Đơn vị nhận báo cáo
• Kỳ báo cáo, thời hạn nhận báo cáo, phương thức gửi

báo cáo
• Biểu mẫu kèm theo giải thích biểu mẫu báo
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Nội dung chế độ báo cáo thống kê

• Mục đích
• Phạm vi thống kê
• Đối tượng áp dụng
• Đơn vị báo cáo
• Đơn vị nhận báo cáo
• Kỳ báo cáo, thời hạn nhận báo cáo, phương thức gửi

báo cáo
• Biểu mẫu kèm theo giải thích biểu mẫu báo

III. KHAI THÁC DỮ LIỆU HỒ SƠ HÀNH CHÍNH

 Khai thác dữ liệu hành chính: Sử dụng dữ liệu hành

chính cho hoạt động thống kê nhà nước là hình thức

thu thập dữ liệu, thông tin thống kê về đối tượng

nghiên cứu cụ thể từ dữ liệu hành chính.

 Dữ liệu hành chính là dữ liệu của cơ quan nhà nước

được ghi chép, lưu giữ, cập nhật trong các hồ sơ

hành chính dạng giấy hoặc dạng điện tử.
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Nội dung sử dụng dữ liệu hành chính trong hoạt 
động thống kê nhà nước

• Tổng hợp số liệu thống kê, biên soạn các chỉ tiêu

thống kê và lập báo cáo theo chế độ báo cáo thống kê;

• Lập hoặc cập nhật dàn mẫu cho điều tra thống kê;

• Xây dựng, cập nhật cơ sở dữ liệu thống kê.

Cơ sở dữ liệu hành chính được sử dụng trong hoạt 
động thống kê nhà nước

• Cơ sở dữ liệu về con người;
• Cơ sở dữ liệu về đất đai;
• Cơ sở dữ liệu về cơ sở kinh tế;
• Cơ sở dữ liệu về thuế;
• Cơ sở dữ liệu về hải quan;
• Cơ sở dữ liệu về bảo hiểm;
• Cơ sở dữ liệu hành chính khác.
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I

PHÂN TỔ 
THỐNG KÊ

II

BẢNG 
THỐNG KÊ

III

ĐỒ THỊ 
THỐNG KÊ

CHƯƠNG III: TỔNG HỢP THỐNG KÊ

1 Khái niệm

2 Các loại phân tổ

3 Các bước tiến hành phân tổ

2. Phân tổ thống kê
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 Khái niệm phân tổ thống kê

Phân tổ thống kê là căn cứ vào một (hay một số) 
tiêu thức nào đó để tiến hành phân chia các đơn 
vị của hiện tượng nghiên cứu thành các tổ (hoặc 
các tiểu tổ) có tính chất khác nhau

 Ý nghĩa phân tổ thống kê

Có ý nghĩa trong cả quá trình nghiên cứu thống kê

• Giai đoạn điều tra thống kê
• Giai đoạn tổng hợp thống kê

• Giai đoạn phân tích thống kê
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 Nhiệm vụ phân tổ thống kê

• Phân chia các loại hình KTXH.

• Biểu hiện kết cấu của hiện tượng nghiên cứu.

• Nghiên cứu mối liên hệ giữa các tiêu thức.

Các loại phân tổ thống kê

Phân tổ thống kê 

Nhiệm vụ phân tổ 
thống kê 

Số lượng tiêu thức 
phân tổ

Phân tổ 
phân 
loại

Phân tổ 
kết cấu

Phân tổ 
liên hệ

Phân tổ đơn Phân tổ theo 
nhiều tiêu thức

Phân tổ 
kết hợp

Phân tổ 
nhiều chiều
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Các bước phân tổ thống kê

Phân phối các đơn vị vào từng tổ

Xác định số tổ và khoảng cách tổ

Lựa chọn tiêu thức phân tổ

Bước 3

Bước 2

Bước 1

B1. Lựa chọn tiêu thức phân tổ

Tiêu thức phân tổ là tiêu thức được chọn làm
căn cứ để tiến hành phân tổ thống kê.
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B2. Xác định số tổ và khoảng cách tổ

TH1: Phân tổ theo tiêu thức thuộc tính

 Có ít biểu hiện: mỗi loại hình hình thành nên 1 tổ

 Có nhiều biểu hiện: ghép các biểu hiện gần giống
nhau thành một tổ

 Xác định số tổ và khoảng cách tổ 

TH2: Phân tổ theo tiêu thức số lượng

 Có ít biểu hiện (lượng biến): mỗi lượng biến là cơ sở để

hình thành một tổ, gọi là phân tổ không có khoảng cách tổ

 Có nhiều biểu hiện (lượng biến): căn cứ vào quan hệ

lượng - chất, mỗi tổ sẽ bao gồm một phạm vi lượng biến
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B3. Phân phối các đơn vị vào từng tổ

Sắp xếp các đơn vị vào từng tổ tương ứng với
biểu hiện của từng tổ

Dãy số phân phối

 Dãy số phân phối theo tiêu thức thuộc tính
 Dãy số phân phối theo tiêu thức số lượng (dãy số lượng biến)
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II. Bảng thống kê

Bảng thống kê là một hình thức trình bày các tài liệu thống

kê một cách có hệ thống, hợp lý và rõ ràng, nhằm nêu lên các

đặc trưng về mặt lượng của hiện tượng nghiên cứu

Các loại bảng thống kê

Bảng giản đơn: là loại bảng thống kê, trong đó hiện

tượng chỉ phân tổ theo một tiêu thức nào đó

Bảng kết hợp: là loại bảng thống kê trong đó đối tượng 

nghiên cứu được phân chia theo từ hai tiêu thức trở lên
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Nguyên tắc khi trình bày bảng thống kê

- Quy mô bảng vừa phải

- Đơn vị tính – nếu tất cả có cùng đơn vị tính thì ghi góc

phải phía trên bảng

- Các chỉ tiêu được sắp xếp theo thứ tự hợp lý

- Không được để trống ô nào trong bảng, nếu không có

dữ liệu thì ghi bằng các ký hiệu

Nguyên tắc ghi ký hiệu

- Nếu hiện tượng không có số liệu, ghi ( - )

- Nếu số liệu còn thiếu, có thể bổ sung ( … )

- Nếu hiện tượng không liên quan ( x )
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III. Đồ thị thống kê

Là các hình vẽ hoặc đường nét hình học dùng để

miêu tả có tính chất quy ước các tài liệu thống kê

Các loại đồ thị

- Đồ thị phát triển

- Đồ thị kết cấu

- Đồ thị so sánh

- Đồ thị liên hệ

- Đồ thị “tháp dân số”
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Các thành phần của đồ thị thống kê

Các thành phần của dữ liệu dùng để trình bày dữ liệu: 

các thanh, đường thẳng, các khu vực hoặc các điểm.

Các thành phần hỗ trợ trong việc tìm hiểu dữ liệu: tiêu 

đề, ghi chú, nhãn dữ liệu, các đường lưới, chú thích và 

nguồn dữ liệu.

Các thành phần dùng để trang trí không liên quan đến 

dữ liệu.

Nguyên tắc trình bày đồ thị

- Quy mô của đồ thị hợp lý (chiều dài, chiều cao).

- Lựa trọn dạng đồ thị phù hợp

- Khoảng cách giữa các cột hợp lý

- Thang đo, tỷ lệ xích phù hợp (tỷ lệ 1: 1,33 hoặc 1:1,5)

- Không nên có quá nhiều hiện tượng trong một đồ thị
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ỨNG DỤNG SPSS 
TRONG TỔNG HỢP THỐNG KÊ 

Phân tổ thống kê

Thực hiện đối với biến thuộc tính
Analyze  Descriptive Statistics  Frequencies…

Đưa các biến cần
lập bảng sang ô
Variable(s)

Hiện thị bảng tần số
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Lập bảng thống kê

Bảng kết hợp nhiều biến (định tính –

định tính; định tính – định lượng)

Analyze > Tables > Custom Tables...

Đưa các biến (định tính hoặc định lượng)

vào Rows và Columns

Đồ thị thống kê

+ Bar: Đồ thị thanh/cột (biểu diễn phân phối của dữ liệu)
+ Line: Đồ thị đường gấp khúc (biểu diễn xu hướng)
+ Area: Đồ thị diện tích
+ Pie: Đồ thị hình tròn (biểu diễn cơ cấu)
+ Boxplot: Đồ thị hộp (biểu diễn phân phối, xác định Outliers)
+ Population Pyramid: Tháp dân số (Đặc trưng dân số theo
tuổi và giới tính)
+ Scatter/Dot: Đồ thị điểm (biểu diễn mối liên hệ giữa các
biến)
+ Histogram: Đồ thị tần số (biểu diễn phân phối của dữ liệu)
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Đồ thị thống kê

Simple đồ thị thanh cho 1 biến

Clustered đồ thị thanh kết hợp 2 biến (theo nhóm

với nhiều cột cạnh nhau)

Stacked Đồ thị thanh kết hợp 2 biến (biến được

biệu hiện trên 1 cột)

Summaries for groups cases Mỗi thanh của đồ

thị thể hiện số lượng các quan sát có cùng 1 giá

trị của biến

Summaries for separate variables Mỗi thanh

của đồ thị thể hiện giá trị thống kê của biến

Value of individual cases Mỗi thanh của đồ thị

thể hiện giá trị 1 quan sát của biến

Đồ thị thanh (Bar) Graphs > Lagacy > Dialogs > Bar...

Đồ thị thống kê

Bars Represent tham số thống kê thể hiện

trên đồ thị

Category Axis Trục hoành

Define Clusters by biến phân loại

Có thể vẽ theo dòng hay cột (theo biến phân

loại thứ 2)  đưa biến vào Panel by Rows
(Columns)

Đồ thị thanh (Bar) Graphs > Lagacy > Dialogs > Bar...
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I

SỐ TUYỆT ĐỐI 
VÀ 

SỐ TƯƠNG ĐỐI 
TRONG 

THỐNG KÊ

II

CÁC MỨC ĐỘ 
TRUNG TÂM

III

CÁC THAM SỐ 
ĐO ĐỘ 

BIẾN THIÊN 
(PHÂN TÁN)

CHƯƠNG IV: CÁC MỨC ĐỘ THỐNG KÊ MÔ TẢ

I. Số tuyệt đối và số tương đối trong
thống kê

Số tuyệt đối trong thống kê1

Số tương đối trong thống kê2

Điều kiện vận dụng số tuyệt đối và số tương đối trong thống kê3
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Khái niệm

Đơn vị tính

Các loại

1. Số tuyệt đối trong thống kê

Khái niệm số tuyệt đối

Số tuyệt đối trong thống kê biểu hiện quy mô, khối
lượng của hiện tượng nghiên cứu tại thời gian, địa
điểm.
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- Đơn vị hiện vật: + Tự nhiên: cái, chiếc, m, kg,…

+ Thời gian: ngày, giờ,…

+ Quy chuẩn:

+ Kép: tấn-km, kwh,..

- Đơn vị giá trị: VND, USD,…

Đơn vị tính số tuyệt đối

Thời điểm: quy
mô, khối lượng

tại một thời
điểm nhất định

Thời kỳ: quy
mô, khối lượng

trong một
khoảng thời

gian

Số tuyệt đối

Các loại số tuyệt đối
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Khái niệm

Đơn vị tính

Các loại

2. Số tương đối trong thống kê

Khái niệm số tương đối

Số tương đối trong thống kê biểu hiện quan hệ so 

sánh giữa hai mức độ nào đó của hiện tượng. 
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Đơn vị tính

 Lần, phần trăm (%) phần nghìn (‰)

 Đơn vị kép: người/km2, sản phẩm/người...

Các loại số tương đối

• Số tương đối động thái (tốc độ phát triển)

)100(
0y

yK KH
N 

)100(1

KH
T y

yK 

TN KKt 

• Số tương đối kế hoạch (lập và kiểm tra kế hoạch)

– Số tương đối nhiệm vụ kế hoạch 

• Mối quan hệ:

– Số tương thực hiện kế hoạch

)100(
0

1

y
yt 
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• Số tương đối kết cấu: Phản ánh tỷ trọng của từng bộ phận cấu
thành trong một tổng thể. 

(100)   i
i

i

y
yd




Các loại số tương đối

• Số tương đối không gian: so sánh giữa hai hiện tượng cùng 
loại nhưng khác nhau về không gian hoặc là quan hệ so sánh 
mức độ giữa hai bộ phận trong một tổng thể

Các loại số tương đối
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• Số tương đối cường độ: quan hệ so sánh giữa hai hiện
tượng khác loại nhưng có quan hệ với nhau. 

Các loại số tương đối

3. Điều kiện vận dụng số tương đối và
tuyệt đối trong thống kê

• Phân tích lý luận KTXH, đặc điểm của hiện tượng
nghiên cứu để rút ra kết luận

• Vận dụng kết hợp số tương đối với số tuyệt đối
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II. Các mức độ trung tâm

Số bình quân (trung bình)1

Mốt (Mo)2

Trung vị (Me)3

Khái niệm chung 

Các loại số bình quân

Đặc điểm của số bình quân

Điều kiện vận dụng số bình quân trong thống kê 

1. Số bình quân (trung bình)
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* Khái niệm

 Số bình quân là mức độ đại biểu theo một
tiêu thức nào đó của một tổng thể bao gồm
nhiều đơn vị.

* Tác dụng

• Phản ánh mức độ đại biểu, nêu lên đặc trưng chung nhất
của tổng thể

• So sánh các hiện tượng không có cùng quy mô.
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* Các loại số bình quân

Số trung bình = Tổng lượng biến của tiêu thức
Tổng số đơn vị

a. Số bình quân cộng (áp dụng khi các lượng biến có
quan hệ tổng)

a. Số bình quân cộng

 Số bình quân cộng giản đơn (khi dữ liệu chưa phân tổ)

n
    

x  ...  x  x
  n21 
 ix

n
x
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a. Số bình quân cộng

 Số bình quân cộng gia quyền








i

i

n2

n21    
  ...    

  ...    
  

f
fx

fff
fxfxfxx in

1

21

 idxx i   
i

i

f
fd


   i

* Các loại số bình quân

b. Số bình quân nhân (áp dụng khi các lượng biến có
quan hệ tích)
 Số bình quân nhân giản đơn

 x     x...  x x  x n
i

n
n  21

  i ii n f f
i

f f
n

ff x     x...  x x  x 21
21

 Số bình quân nhân gia quyền
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* Đặc điểm của số bình quân

•Mang tính tổng hợp, khái quát.

•San bằng các chênh lệch giữa các đơn vị về trị số của tiêu

thức nghiên cứu.

* Điều kiện vận dụng số bình quân

• Số bình quân chỉ nên tính ra từ tổng thể đồng
chất.

• Số bình quân chung cần được vận dụng kết hợp
với các số bình quân tổ hoặc dãy số phân phối.
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Khái niệm

Cách xác định

Tác dụng

2. Mốt (Mode) 

Khái niệm  

Mốt là biểu hiện của tiêu thức phổ biến nhất (gặp

nhiều nhất) trong một tổng thể hay trong một dãy số

phân phối
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Cách xác định  

 Đối với trường hợp phân tổ không có khoảng cách tổ, 
mốt là lượng biến có tần số lớn nhất.

max) i(f x  ioM

Cách xác định  

 Đối với trường hợp phân tổ có khoảng cách tổ
Bước1: Xác định tổ có mốt

Tổ có fi=max => Phân tổ có khoảng cách bằng nhau
Tổ có mi=max => Phân tổ có khoảng cách không bằng nhau
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Cách xác định  

Bước 2: Xác định trị số gần đúng của mốt:

21

1
MM   

 
h  x  

oo 



 (min)oM

1

1








MoMo

MoMo

ff
ff

2

1




1

1








MoMo

MoMo

mm
mm

2

1




Khoảng cách bằng nhau

Khoảng cách không bằng nhau

Tác dụng

• Có thể thay thế hoặc bổ sung cho trung bình cộng trong
trường hợp tính trung bình gặp khó khăn

• Có ý nghĩa hơn số bình quân cộng trong trường hợp dãy số có
lượng biến đột xuất

• Là một trong những tham số nêu lên đặc trưng phân phối của
dãy số

• Có tác dụng trong phục vụ nhu cầu hợp lý
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Khái niệm

Cách xác định

Tác dụng

3. Trung vị (Median) 

Khái niệm  

Trung vị là lượng biến của đơn vị đứng ở vị trí giữa

trong một dãy số, chia dãy số thành hai phần bằng nhau
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Cách xác định   

+ Nếu số đơn vị tổng thể lẻ (fi = 2m + 1): 1mx Me

2
1mx  

 mxMe+ Nếu số đơn vị tổng thể chẵn (fi = 2m): 

 Trường hợp phân tổ không có khoảng cách tổ 

Cách xác định   

Trường hợp phân tổ có khoảng cách tổ:
- Bước 1: Xác định tổ chứa Me (tổ chứa đơn vị ở vị trí giữa 

trong dãy số)
- Bước 2: Xác định trị số gần đúng

Me

i

f

f

Me
-1)(Me

MeMe

 S- 
h  x  2

(min)



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Tác dụng  

min ii fMex

• Có thể thay thế hoặc bổ sung cho trung bình cộng trong
trường hợp tính trung bình gặp khó khăn

• Có ý nghĩa hơn số bình quân cộng trong trường hợp dãy số có
lượng biến đột xuất

• Là một trong những tham số nêu lên đặc trưng phân phối của
dãy số

• Có tác dụng trong phục vụ công cộng vì 

* Đặc trưng phân phối của dãy số

X = Me = Mo

Đối xứng Mo Me X 

Lệch phải

X Me Mo

Lệch trái
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III. Các tham số đo độ phân tán (biến
thiên)

Khoảng biến thiên1

Độ lệch tuyệt đối bình quân2

Phương sai3

Độ lệch tiêu chuẩn4

Hệ số biến thiên5

1. Khoảng biến thiên

• Công thức tính:
R = Xmax - Xmin
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2. Độ lệch tuyệt đối bình quân

• Công thức tính

n

x - x
  d i




i

ii

f

f x - x
  d (cã quyÒn sè)

3. Phương sai

Công thức tính:

1
2


 

n
S

2
i )x - (x

  





1
2

i

2
i

f

)x - (x
  ifS (có quyền số)

Công thức thực hành (khi có quyền số):

 
  







































2222

2

111
  

i

ii

i

ii

i

i

ii

ii

i

ii

f
fx

f
fx

f
f

ff
fx

f
fxS

 222

1
  xx

f
fS

i

i 





CuuDuongThanCong.com https://fb.com/tailieudientucntt

http://cuuduongthancong.com?src=pdf
https://fb.com/tailieudientucntt


1/9/2020

21

4. Độ lệch tiêu chuẩn

• Công thức tính: 2SS   

5. Hệ số biến thiên

• Công thức tính: 100  
x

  
SV

CuuDuongThanCong.com https://fb.com/tailieudientucntt

http://cuuduongthancong.com?src=pdf
https://fb.com/tailieudientucntt


1/9/2020

22

Thực hiện bằng SPSS

43

Chọn Analyze > Descriptive Statistics > Frequencies…

Đưa các biến cần tính toán các
tham số sang Variable(s)
Nhấn Statistic…

Thực hiện bằng SPSS

44

Chọn Analyze > Descriptive Statistics > Frequencies…

Chọn các thống kê cần tính toán
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I

NHỮNG VẤN 
ĐỀ CHUNG VỀ 

ĐIỀU TRA 
CHỌN MẪU

II

CƠ SỞ ƯỚC 
LƯỢNG VÀ 
KIỂM ĐỊNH

III

ƯỚC LƯỢNG 
KẾT QUẢ ĐIỀU 

TRA CHỌN 
MẪU 

CHƯƠNG V: ĐIỀU TRA CHỌN MẪU

IV

KIỂM ĐỊNH GIẢ 
THUYẾT THỐNG 

KÊ 

I. Những vấn đề chung

Khái niệm1

Ưu điểm2

Trường hợp vận dụng4

Hạn chế3

Tổng thể chung và tổng thể mẫu5

Cách chọn mẫu6
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Khái niệm

Ưu điểm
+ Tiết kiệm (chi phí, nhân lực, thời gian)

+ Mở rộng nội dung điều tra

+ Tài liệu có độ chính xác cao

+ Tổ chức đơn giản
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Hạn chế
+ Không cho biết thông tin đầy đủ về tổng thể

+ Sai số khi suy rộng

+ Kết quả điều tra không thể tiến hành phân tổ theo 

mọi phạm vi nghiên cứu

Trường hợp vận dụng

• Thay thế cho điều tra toàn bộ
• Kết hợp với điều tra toàn bộ
• Kiểm định giả thuyết thống kê
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Tổng thể chung và tổng thể mẫu

Chỉ tiêu Tổng thể chung Tổng thể mẫu

Quy mô

Số bình quân
Tỷ lệ theo một 
tiêu thức

Phương sai

 x

2

)1( ff 

2S

)1( pp 

p f

N ifn 

Chọn hoàn lại (Chọn nhiều lần, chọn lặp)

nNk 

Cách chọn mẫu
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Chọn không hoàn lại, (Chọn 1 lần, chọn không lặp)

 !!
!

nNn
Nk




Cách chọn mẫu

II. CƠ SỞ ƯỚC LƯỢNG KIỂM 
ĐỊNH GIẢ THUYẾT THỐNG KÊ 

Biến ngẫu nhiên1

Quy luật phân phối biến ngẫu nhiên2
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BIẾN NGẪU NHIÊN

• Biến ngẫu nhiên là biến nhận một trong các giá trị
có thể có của nó tuỳ thuộc vào sự tác động của các
nhân tố ngẫu nhiên trong một phép thử.

• Biến ngẫu nhiên là biến mà các giá trị không được
xác định trước qua mỗi lần thực nghiệm (phép thử).

Xác suất?

Xác suất của một biến cố là một con số đặc 
trưng khả năng khách quan xuất hiện biến cố 
đó khi thực hiện phép thử
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Quy luật phân phối xác suất

• Quy luật phân phối xác suất của biến ngẫu nhiên là sự

tương ứng giữa giá trị có thể có của nó và xác suất tương

ứng với giá trị đó.

13

Quy luật phân phối chuẩn
• Nếu X~N(µ, 2)

• Hàm mật độ xác suất

14
µ

2

2

2
)(

2
1)( 









x

exf
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Quy luật phân phối chuẩn

15

µ
68,26%

95,44%

99,74%

Quy luật phân phối chuẩn hoá

• Nếu X~N(0, 1)

• Hàm mật độ xác suất

16

0

2

2

2
1)(

x

exf





1,96-1,96
95%
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Quy luật phân phối chuẩn hoá

• Nếu X phân phối chuẩn: X~N(µ, 2)

• Thì biến ngẫu nhiên sẽ phân phối chuẩn

hóa

17

0

)1,0(~ NxZ





1,96-1,96
95%

Định lý giới hạn trung tâm

• Nếu 

 2,~ xNx 

)1,0(~ NxZ
x




 2,~ NX

• Thì với mẫu ngẫu nhiên kích thước n
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Định lý giới hạn trung tâm

• Nếu tổng thể có phân phối chuẩn thì phân 
phối của trung bình mẫu cũng có phân phối 
chuẩn

• Với kích thước mẫu đủ lớn thì phân phối 
trung bình và tỷ lệ mẫu sẽ xấp xỉ phân phối 
chuẩn

II. Ước lượng kết quả điều tra

Ước lượng (suy rộng) kết quả điều tra 1

Xác định kích thước (quy mô) mẫu2
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1. Ước lượng kết quả điều tra

• Công thức chung   '

: tham số của tổng thể chung
: thống kê mẫu'
: phạm vi sai số chọn mẫu 

Các nguyên nhân sai số trong ĐTCM

- Vi phạm nguyên tắc chọn mẫu ngẫu nhiên
- Số lượng đơn vị mẫu không đủ lớn
- Kết cấu tổng thể mẫu khác với kết cấu tổng thể

chung
- Sai số do đăng ký, ghi chép
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Ước lượng kết quả điều tra
• Với mức ý nghĩa α
• Ước lượng trung bình

xx zxzx   .. 2/2/ 

Khi biết phương sai tổng thể chung (hoặc chưa biết phương
sai tổng thể chung & mẫu lớn)

Khi chưa biết phương sai tổng thể chung
xzx   .

  xzx .

x
n

x
n txtx   .. 11

2/2/
 

   x
ntx .1

x
ntx   .1

Hai phía
Vế phải
Vế trái

Hai phía
Vế phải
Vế trái

Ước lượng kết quả điều tra

• Với mức ý nghĩa α

• Ước lượng tỷ lệ

ff zfpzf   .. 2/2/ 
 pzf f .

fzxp  .

Hai phía
Vế phải
Vế trái
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Ước lượng kết quả điều tra

 Trong đó được gọi là hệ số tin cậy (giá trị tới hạn mức α

của phân phối chuẩn hoá và phân phối Student)
 tz ,

• α – mức ý nghĩa

• (1-α) là xác suất hay trình độ tin cậy

Ước lượng kết quả điều tra

Một số giá trị đặc biệt của phân phối chuẩn hoá

Z/2 Xác suất tin cậy
1 0,6826
2 0,9544
3 0,9974

Xác suất tin cậy Mức ý nghĩa Z/2
0,900 0,100 1,645 
0,950 0,050 1,960 
0,975 0,025 2,326
0,990 0,010 2,576

 được gọi là sai số bình quân chọn mẫufx  ,
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Sai số bình quân chọn mẫu
Cách chọn

Suy rộng
Hoàn lại

(chọn nhiều lần)
Không hoàn lại
(chọn một lần)

Số bình quân

Tỷ lệ

nx

2 

n
S

x

2



)1(
2

N
n

nx 


)1(
2

N
n

n
S

x 

n
ff

f
)1( 

 )1()1(
N
n

n
ff

f 




2. Xác định số đơn vị mẫu điều tra

• Yêu cầu:
+ Sai số nhỏ nhất
+ Chi phí thấp nhất
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Cách xác định

Cách chọn
Suy rộng

Chọn hoàn lại
(chọn nhiều lần)

Chọn không hoàn lại
(chọn một lần)

Bình quân

Tỷ lệ

2

22
2/

x

zn

 22

2/
2

22
2/

..
..








zN
zNn

x 


2

2
2/ )1(.

f

ppzn


 
 )1(..

)1(..
2

2/
2

2
2/

ppzN
ppzNn

f 









xx z   2/

ff z   2/ Phạm vi sai số chọn mẫu

+ Lấy phương sai lớn nhất hoặc tỷ lệ gần 0,5 nhất
trong các lần điều tra trước

+ Lấy phương sai hoặc tỷ lệ của các cuộc điều tra khác
có tính chất tương tự.

+ Điều tra thí điểm để xác định phương sai hoặc tỷ lệ.
+ Ước lượng phương sai dựa vào khoảng biến thiên

66
minmax Rxx






Một số phương pháp xác định
phương sai tổng thể chung
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IV. Kiểm định giả thuyết thống kê 

Những vấn đề chung về kiểm định giả thuyết thống kê1

Kiểm định giá trị trung bình của 1 tổng thể2

Giả thuyết thống kê
Là giả thuyết về một vấn đề nào đó của tổng thể
chung (về các tham số như trung bình, tỷ lệ, 
phương sai, dạng phân phối,…) 
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Giả thuyết thống kê
Giả thuyết mà ta muốn kiểm định (H0)

Giả thuyết đối lập (H1, Ha, H)

Giả thuyết thống kê
Kiểm định 2 phía, kiểm định phía trái/phải

Ví dụ:

H0:  = 0

H1:   0

0

Bác bỏ H0 Bác bỏ H0

CuuDuongThanCong.com https://fb.com/tailieudientucntt

http://cuuduongthancong.com?src=pdf
https://fb.com/tailieudientucntt


1/9/2020

18

Sai lầm và mức ý nghĩa trong kiểm định

- Sai lầm loại I là bác bỏ H0 khi H0 đúng

- Sai lầm loại II là chấp nhận H0 khi H0 sai

Kết luận
Thực tế Chấp nhận H0 Bác bỏ H0

H0 đúng Kết luận đúng Sai lầm loại I

H0 sai Sai lầm loại II Kết luận đúng

Sai lầm và mức ý nghĩa trong kiểm định

Mức ý nghĩa của kiểm định () là xác suất
mắc sai lầm loại I
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Tiêu chuẩn kiểm định
Tiêu chuẩn kiểm định là quy luật phân phối 
xác suất nào đó dùng để kiểm định.

Trong tập hợp các kiểm định thống kê có cùng 
mức ý nghĩa , kiểm định nào có xác suất mắc 
sai lầm loại 2 nhỏ nhất được xem là “tốt nhất”.

Các bước tiến hành kiểm định

- Xây dựng giả thuyết H0 và giả thuyết đối H1

- Xác định mức ý nghĩa 

- Chọn tiêu chuẩn kiểm định

- Tính giá trị của tiêu chuẩn kiểm định từ mẫu 
quan sát

- Kết luận
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Kết luận
Quy tắc kiểm định giả thuyết thống kê

- Nếu giá trị tiêu chuẩn kiểm định thuộc miền bác
bỏ (W), có cơ sở để bác bỏ H0

- Nếu giá trị của tiêu chuẩn kiểm định không
thuộc miền bác bỏ, chưa đủ cơ sở để bác bỏ H0

Phương pháp tiếp cận P-value trong kiểm
định giả thuyết

• P-value là xác suất lớn nhất để có thể
bác bỏ giả thuyết H0. 

• Các nguyên tắc ra quyết định để bác bỏ
giả thuyết H0 với P-value là:

• Nếu p-value lớn hơn hoặc bằng α, chưa
đủ cơ sở để bác bỏ giả thuyết H0.

• Nếu p-value nhỏ hơn α, bác bỏ giả thuyết
H0.
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2. Kiểm định giá trị trung bình của 1 
tổng thể

- Giả sử nghiên cứu X  N(, 2)

- Chưa biết  song có cơ sở để giả định nó bằng
0 (H0:  = 0)

- Để kiểm định giả thuyết trên, lấy ngẫu nhiên n 
đơn vị từ đó tính các thống kê mẫu.

- Tiêu chuẩn kiểm định

2. Kiểm định giá trị trung bình của
1 tổng thể

Khi đã biết phương sai tổng thể chung

Tiêu chuẩn kiểm định
n

xZ
/

)( 0






Nếu H0 đúng -> Thống kê Z sẽ tuân theo quy luật
phân phối chuẩn hoá
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Miền bác bỏ W

- Hai phía: Zqs > z/2

- Vế phải: Zqs > z
- Vế trái: Zqs < -z

2. Kiểm định giá trị trung bình
của 1 tổng thể

2. Kiểm định giá trị trung bình của
1 tổng thể

Khi chưa biết phương sai tổng thể chung

Tiêu chuẩn kiểm định

Trong đó

nS
xT

/
)( 0

 22
2

2 )(
11

)( xx
f

f
f

fxxS
i

i

i

ii 










Nếu H0 đúng -> Thống kê T sẽ tuân theo quy luật
phân phối Student với bậc tự do là (n-1)
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Miền bác bỏ W

- Hai phía: Tqs > t/2(n-1)

- Vế phải: Tqs > t(n-1)

- Vế trái: Tqs < -t(n-1)

2. Kiểm định giá trị trung bình
của 1 tổng thể

ỨNG DỤNG SPSS 
TRONG ƯỚC LƯỢNG VÀ KIỂM ĐỊNH GIẢ 

THUYẾT THỐNG KÊ 
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Ước lượng thống kê

47

Chọn Analyze > Descriptive Statistics > Explore …

Đưa các biến cần tính toán các
tham số sang Dependent List
Muốn phân tích theo biến nào
đó thì đưa sang biến sang
Factor List
Trong mục Display chọn
Statistics hoặc Both

Kiểm định giả thiết về giá trị trung
bình của một tổng thể

48

Analyze > Compare Means > One-Sample T Test…

Đưa các biến cần kiểm định giá trị 
trung bình vào Test Variable(s)

Nhập giá trị cần kiểm định trung 
bình vào Test Value

Nhấn Options...
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Kiểm định giả thiết về giá trị trung
bình của một tổng thể

49

Analyze > Compare Means > One-Sample T Test…

Nhập độ tin cậy của kiểm định vào 
Confidence Interval

Chỉ kiểm định đối với các quan sát 
có ý nghĩa của biến chọn Exclude 
cases analysis by analysis

Chỉ kiểm định đối với các quan sát 
có đầy đủ trong các biến chọn 
Exclude cases listwise (n như
nhau)
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I

NHỮNG VẤN ĐỀ 
CHUNG VỀ 
PHÂN TÍCH
HỒI QUY VÀ 

TƯƠNG QUAN

II

PHÂN TÍCH HỒI 
QUY TUYẾN 
TÍNH ĐƠN

III

PHÂN TÍCH HỒI 
QUY TUYẾN 

TÍNH BỘI

CHƯƠNG VI: PHÂN TÍCH HỒI QUY VÀ 
TƯƠNG QUAN

I. Những vấn đề chung về phân tích hồi
quy và tương quan

Mối liên hệ của các hiện tượng kinh tế xã hội1

Nhiệm vụ của phân tích hồi quy và tương quan2
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1. Mối liên hệ của các hiện tượng kinh tế xã hội

Liên hệ hàm số

Liên hệ tương quan

Liên hệ hàm số

• Khái niệm: liên hệ hàm số là mối liên hệ hoàn toàn 
chặt chẽ

• Đặc điểm: Liên hệ được biểu hiện trên từng đơn vị 
cá biệt
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Liên hệ tương quan

• Khái niệm: liên hệ tương quan là mối liên hệ không
hoàn toàn chặt chẽ.

• Đặc điểm: Liên hệ không được biểu hiện trên từng
đơn vị cá biệt mà phải quan sát số lớn

2. Nhiệm vụ của phân tích hồi quy và tương
quan

 Xây dựng phương trình hồi quy.

 Đánh giá trình độ chặt chẽ của mối liên hệ
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II. Hồi quy – tương quan đơn

Xây dựng phương trình hồi quy1

Đánh giá phương trình hồi quy2

1. Phương trình hồi quy

 Đường hồi quy lý thuyết: là đường điều chỉnh bù trừ các chênh
lệch ngẫu nhiên nêu ra mối liên hệ cơ bản của hiện tượng.

 Phương trình hồi quy: là phương trình xác định vị trí của đường
hồi quy lý thuyết

Đường hồi quy lý thuyết



x

y

0




 





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Phương trình hồi quy tổng thể

iii xY   10

Tham số tự do (hệ số chặn)

Biến độc lập
Nguyên nhân
Biến giải thích
Công cụ dự báo
Ngoại sinh
Tác nhân kích thích

Hệ số hồi quy (hệ số góc)

Biến phụ thuộc
Kết quả
Biến được giải thích
Dự báo
Nội sinh
Câu trả lời

Ý nghĩa các tham số

• β0: phản ánh ảnh hưởng của các nguyên nhân khác
(ngoài nguyên nhân x) tới kết quả y

• β1: phản ánh ảnh hưởng trực tiếp của nguyên nhân x tới
kết quả y. Cụ thể, khi x tăng thêm 1 đơn vị thì y thay đổi
bình quân là β1 đơn vị

β1 > 0: x và y có mối liên hệ thuận (cùng chiều)

β1 < 0: x và y có mối liên hệ nghịch (ngược chiều)
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Phương trình hồi quy mẫu

Ước lượng của tham số β0 Ước lượng của tham số β1

Với một mẫu ngẫu nhiên kích thước n, chúng ta có phương 
trình hồi quy mẫu như sau: 

ii xbby 10ˆ 

Giả thiết OLS

+ Giả thiết 1: Mô hình được ước lượng trên cơ sở mẫu ngẫu nhiên
+ Giả thiết 2: Kỳ vọng toán của sai số bằng không
+ Giả thiết 3: Sai số tuân theo quy luật phân bố chuẩn
+ Giả thiết 4: Phương sai của sai số bằng nhau (không đổi)
+ Giả thiết 5: Không có tương quan giữa các phần dư (không có tự tương
quan)
+ Giả thiết 6: Giữa các biến độc lập không có tương quan tuyến tính hoàn
hảo (đa cộng tuyến) - Đối với hồi quy bội.
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Nội dung phương pháp OLS

Tìm các tham số sao cho tổng bình phương các
chênh lệch giữa giá trị thực tế và giá trị lý thuyết của
tiêu thức kết quả là nhỏ nhất.


















0))(.(2

0)1)(.(2

10
1

10
0

iii

ii

xxbby
b
S

xbby
b
S








2
10

10

..
..

iiii

ii

xbxbxy
xbbny

min)ˆ( 2  ii yyS
min)( 2

10  ii xbbyS

Kiểm định hệ số hồi quy

• Giả thuyết: 

)( j

j

bse
b

T 

0:0 jH 

 








 n

i
i

n

i
i

xxn

x
bse

1

2

2
1

2

0 .)( 
 




 n

i
i xx

bse

1

2

2

1)( 

 
2

ˆ

2
1

2

2












n

yy

n
SSE

n

i
ii



• Tiêu chuẩn kiểm định:

• Nếu H0 đúng thống kê T sẽ tuân theo quy luật phân phối
student với (n-2) bậc tự do. 
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Kiểm định hệ số hồi quy

Miền bác bỏ giả thuyết H0 (W)

- Hai phía: Tqs > t/2 ,(n-2)

- Vế phải: Tqs > t (n-2)

- Vế trái: Tqs < -t(n-2)

Ước lượng hệ số hồi quy

• Hai phía:

• Phái trái:

    )()( 2
2

2
2 j

n
jjj

n
j bsetbbsetb    

  )(2
j

n
jj bsetb  

• Phái phải:    
jj

n
j bsetb  )(2
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Hệ số xác định



x

y

0









 





 



n

i
i yySST

1

2

 



n

i
ii yySSE

1

2ˆ

  
n

i yySSR
1

2ˆ

Hệ số xác định

 



n

i
i yySSR

1

2ˆ

 



n

i
ii yySSE

1

2ˆ

Biến thiên được giải thích bởi hồi quy

Biến thiên do phần dư

Toàn bộ biến thiên của biến phụ thuộc

SST = SSR + SSE

Hệ số xác định
SST
SSE

SST
SSRR  12

Phản ánh phần trăm thay đổi của biến phụ thuộc được giải thích bởi biến độc lập

 



n

i
i yySST

1

2
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Kiểm định ý nghĩa mô hình

Tiêu chuẩn kiểm định

Nếu H0 đúng, thống kê F sẽ tuân theo quy luật phân phối Fisher với bậc tự do (1, n-2)

Với mức ý nghĩa α, Miền bác bỏ giả thuyết H0 khi, F > fα(1.n-2)

Cặp giả thuyết




nghia ý cóhình  Mô:
nghia ý có khônghình  Mô:

1H
Ho

 
 2

2

1
2

2
R

nR

n
SSE
SSRF




















0:
0:

2
1

2

RH
RHo

Hệ số tương quan tuyến tính

Công thức tính

22

22

11
.







 









 








n
y

n
y

n
x

n
x

bbyxyxr
ii

ii

y

x

yx 



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Hệ số tương quan tuyến tính

Tác dụng

- Xác định chiều hướng của mối liên hệ

- Đánh giá mức độ chặt chẽ của liên hệ tương quan

tuyến tính

Tính chất của hệ số tương quan

-1 0 +1 

Liên hệ hàm sốKhông có mối liên hệLiên hệ hàm số
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R2 = 1,Y
Yi = b0 + b1Xi

X

^
r = -1

R2 < 1,Y

Y i = b0 + b1Xi

X
^

r <1

R2 = 1,Y

Y i = b0 + b1Xi
X

^

r = +1

R2 = 0,Y

Y i = b0 + b1Xi

X
^

r = 0

Tính chất của hệ số tương quan

Kiểm định hệ số tương quan

Tiêu chuẩn kiểm định

Nếu H0 đúng, thống kê T sẽ tuân theo quy luật phân phối student với bậc tự
do (n-2)

Với mức ý nghĩa α, Miền bác bỏ giả thuyết H0 khi

Cặp giả thuyết








0:
0:

1 


H
Ho

2
1 2






n
r

rT

2
2
 ntT 

CuuDuongThanCong.com https://fb.com/tailieudientucntt

http://cuuduongthancong.com?src=pdf
https://fb.com/tailieudientucntt


III. Hồi quy – tương quan bội

Xây dựng phương trình hồi quy1

Đánhgiá phương trình2

Phương trình hồi quy tổng thể

ikikiii xxxY   ....22110

β0 - Tham số tự do (hệ số chặn)

βj (j=1-k) Hệ số hồi quy riêng
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Ý nghĩa hệ số hồi quy

• βj: phản ánh ảnh hưởng thuần của nguyên nhân xj tới
kết quả y (khi các yếu tố khác không đổi). Cụ thể, khi xj

tăng thêm 1 đơn vị thì y thay đổi trung bình là βj đơn vị

Phương trình hồi quy mẫu

kikiii xbxbxbby  .....ˆ 22110

bj: Ước lượng của tham số βj

Với một mẫu ngẫu nhiên kích thước n, chúng ta có phương
trình hồi quy mẫu như sau: 
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Kiểm định hệ số hồi quy

• Giả thuyết: 

)( j

j

bse
b

T 

0:0 jH 

• Tiêu chuẩn kiểm định:

• Nếu H0 đúng thống kê T sẽ tuân theo quy luật phân phối
student với (n-k-1) bậc tự do. 

Kiểm định hệ số hồi quy

Miền bác bỏ giả thuyết H0 (W)

- Hai phía: Tqs > t/2 ,(n-k-1)

- Vế phải: Tqs > t (n-k-1)

- Vế trái: Tqs < -t(n-k-1)
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Ước lượng hệ số hồi quy

• Hai phía:

• Phái trái:

    )()( 1
2

1
2 j

kn
jjj

kn
j bsetbbsetb    

  )(1
j

kn
jj bsetb  

• Phái phải:
   

jj
kn

j bsetb  )(1

Hệ số hồi quy chuẩn hoá

• Công thức: 
y

xj
jj bBêta





• Biểu hiện vai trò của từng biến độc lập tới biến thuộc
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Hệ số xác định

 



n

i
i yySSR

1

2ˆ

 



n

i
ii yySSE

1

2ˆ

SST = SSR + SSE

Hệ số xác định
SST
SSE

SST
SSRR  12

Phản ánh phần trăm thay đổi của biến phụ thuộc được giải thích bởi các biến độc lập

 



n

i
i yySST

1

2

Biến thiên được giải thích bởi hồi quy

Biến thiên do phần dư

Toàn bộ biến thiên của biến phụ thuộc

Hệ số xác định điều chỉnh

Hệ số xác định điều chỉnh
1

)1)(1(1

1

11
2

2









kn

nR

n
SST

kn
SSE

Radj

Khi k >1 thì R2
adj ≤ R2≤1

K càng lớn R2
adj càng nhỏ so với R2

R2
adj có thể âm, sẽ quy ước R2

adj = 0

Dùng để so sánh, đánh giá độ phù hợp của mô hình khi số lượng biến trong
mô hình hồi quy khác nhau
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Kiểm định ý nghĩa mô hình

Tiêu chuẩn kiểm định

Nếu H0 đúng, thống kê F sẽ tuân theo quy luật phân phối Fisher với bậc tự do
(k, n-k-1)

Với mức ý nghĩa α, Miền bác bỏ giả thuyết H0 khi, F > fα(k, n-k-1)

Cặp giả thuyết










0:
0:

2
1

2

RH
RHo

 
 2

2

1
1

1
Rk
knR

kn
SSE

k
SSR

F









Hệ số tương quan chung

Công thức 21 R
SST
SSR

SST
SSER 
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Ứng dụng SPSS trong phân tích HQ

37

Analyze > Regression > Linear…

Đưa biến phụ thuộc sang 
Dependent

Đưa các biến độc lập sang 
Independent(s) 
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I

KHÁI NIỆM 
CHUNG VỀ DÃY 
SỐ THỜI GIAN

II

PHÂN TÍCH ĐẶC 
ĐIỂM BIẾN 

ĐỘNG CỦA HIỆN 
TƯỢNG QUA 
THỜI GIAN

III

BIỂU DIỄN XU 
HƯỚNG BIẾN 

ĐỘNG CỦA HIỆN 
TƯỢNG

IV

DỰ ĐOÁN 
THỐNG KÊ 
NGẮN HẠN

CHƯƠNG VII : PHÂN TÍCH DÃY SỐ THỜI GIAN

Khái niệm1

Các loại3

Tác dụng5

Các thành phần4

Cấu tạo2

I. KHÁI NIỆM CHUNG VỀ DÃY SỐ THỜI GIAN

Yêu cầu6
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1. Khái niệm

Dãy số thời gian là một dãy trị số của chỉ tiêu
thống kê được sắp xếp theo thứ tự thời gian

2. Cấu tạo

Thời gian: ngày, tháng, quý,năm,… Độ dài

giữa hai thời gian là khoảng cách thời gian

Chỉ tiêu về hiện tượng nghiên cứu: tên chỉ

tiêu, đơn vị tính và trị số chỉ tiêu yi (i=1,n) là

mức độ của dãy số thời gian
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3. Các loại

Dãy số tuyệt đối

 Dãy số tương đối

 Dãy số bình quân

Thời điểm

 Thời kỳ
DS-TG

4. Các thành phần

Xu hướng (T)

Thời vụ/chu 
kỳ (S) Các yếu tố 

ngẫu nhiên 
(I)

ISTY 

ISTY 

Mô hình kết hợp cộng

Mô hình kết hợp nhân
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5. Tác dụng

 Nghiên cứu các đặc điểm biến động của hiện
tượng, và xác định xu hướng và tính quy luật của sự
phát triển.

 Là cơ sở dự đoán các mức độ của hiện tượng.

6. Yêu cầu

Đảm bảo tính chất có thể so sánh được 
giữa các mức độ của dãy số thời gian
 Thống nhất về nội dung và phương pháp 
tính.
 Thống nhất về phạm vi.
 Khoảng cách thời gian trong dãy số thời kỳ 
phải bằng nhau.
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II. Các chỉ tiêu phân tích đặc điểm biến 
động của hiện tượng qua thời gian

Mức độ bình quân qua thời gian1

Tốc độ phát triển 3

Giá trị tuyệt đối của 1% của tốc độ tăng (giảm)5

Tốc độ tăng (giảm)4

Lượng tăng (giảm) tuyệt đối 2

1. Mức độ bình quân qua thời gian

 Ý nghĩa: Mức độ bình quân theo thời gian phản ánh

mức độ đại biểu của tất cả các mức độ của dãy số.

n

y

n
yyyyy

n

i
i

nn

 


 1121 ...

Cách tính

* Đối với dãy số thời kỳ:
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1. Mức độ bình quân qua thời gian
* Đối với dãy số thời điểm:

2
CKDK yyy 

- Dãy số biến động đều:

* Đối với dãy số thời điểm:

1
2

...
2 12

1








n

yyyy

y
n

n

- Dãy số biến động không đều
+ Có số liệu tại thời điểm có khoảng cách thời gian
bằng nhau:

1. Mức độ bình quân qua thời gian

* Đối với dãy số thời điểm:

i

ii

t
tyy






- Dãy số biến động không đều
+ Có số liệu tại thời điểm có khoảng cách thời gian
không bằng nhau:
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2. Lượng tăng (giảm) tuyệt đối

Ý nghĩa: Phản ánh sự biến động về trị số tuyệt đối của chỉ tiêu 
qua thời gian
- Liên hoàn

- Định gốc





i

i
ii

2


1 iii yy

1yyii 

- Mối liên hệ

111
12















n
yy

nn
nn

n

i
i

- Bình quân

3. Tốc độ phát triển 

Ý nghĩa: tốc độ và xu hướng biến động của hiện tượng qua 
thời gian
- Liên hoàn

- Định gốc





i

i
ii tT

2

)100(
1


i

i
i y

yt

)100(
1y

yT i
i 

1

1

11

2





  n nn
nn

n

i
i y

yTtt

- Mối liên hệ

- Bình quân
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4. Tốc độ tăng (giảm) 

Ý nghĩa: mức độ của hiện tượng qua thời gian tăng (giảm) đi 
bao nhiêu lần hoặc %
- Liên hoàn

- Định gốc

)100(1(%))100()100(
11

1 






i

i

i

i

ii
i t

yy
yya 

)100(1(%)  ta

)100(1(%))100()100(
11

1 





 i
ii

i T
yy

yyA

- Mối liên hệ:   Không có mối liên hệ

- Bình quân

5. Giá trị tuyệt đối của 1% của tốc độ 
tăng (giảm) 

Ý nghĩa: 1% tăng/giảm của tốc độ tăng/giảm thì tương ứng 
với một trị số tuyệt đối là bao nhiêu
- Liên hoàn

- Định gốc

100100(%)
1

1





 i

i

i

i

i

i
i

y

y
a

g



consty

y
A

G
i

i

i

i
i 








100100(%)

1

1

- Mối liên hệ:   Không có mối liên hệ

- Bình quân: không tính

--> Không tính
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III. Một số phương pháp biểu diễn xu
hướng phát triển cơ bản của hiện tượng

Mở rộng khoảng cách thời gian1

Hàm xu thế3

Số bình quân trượt2

Mở rộng thêm
khoảng cách thời
gian bằng cách

ghép một số thời
gian liền nhau vào
một khoảng thời

gian dài hơn

Khi DSTG có
khoảng cách tương
đối ngắn có quá
nhiều mức độ mà
chưa phản ánh
được xu hướng

phát triển cơ bản
của hiện tượng

Điều kiện
vận dụng Nội dung Hạn chế

- Mất đi ảnh
hưởng của những

nhân tố cơ bản
-Mất đi tính chất
thời vụ của hiện

tượng

1. Mở rộng khoảng cách thời gian
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2. Phương pháp bình quân trượt

k

yyy
y

ki
iki

i







 






 




5,0

2
5,0

2

......

k

yyy
y

ki
iki

i

1
22

......



















Giả sử có dãy số thời gian: y1, y2, y3,… yn

Nếu k lẻ:

Nếu k chẵn:

)5,0
2

;5,0
2

( 
knki

)1
2

;1
2

( 
knki

Hàm số biểu hiện các 
mức độ của hiện 

tượng qua thời gian

Khái niệm Một số dạng 
hàm xu thế

3. Xây dựng hàm xu thế

ii tbby 10ˆ 
2

210ˆ iii tbtbby 

i
i t

bby 1
0ˆ )(ˆ ii tfy 
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Tiêu chuẩn lựa chọn hàm xu thế

Bước 1: Lựa chọn dạng hàm có ý nghĩa: Căn cứ vào giá
trị Sig hoặc p_value của các hệ số trong từng hàm xu thế.

Bước 2: Lựa chọn dạng hàm tốt nhất:

 
min

ˆ
1

2













pn

yy

pn
SSESE

n

i
ii

Sử dụng SPSS trong việc xây dựng hàm xu thế

Data>Define Dates..

22

Định nghĩa thời gian: Dữ liệu thời gian (dữ liệu chuỗi) là dữ liệu mà mỗi
dòng (quan sát) là số liệu ở một thời gian nhất định (tháng, quý, năm,...)
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Xây dựng hàm xu thế
Analyze>Regression > Curve Estimation…

23

IV. Một số phương pháp dự
đoán thống kê đơn giản

Dự đoán dựa vào lượng tăng (giảm) tuyệt đối bình quân1

Dự đoán dựa vào hàm xu thế3

Dự đoán dựa vào tốc độ phát triển bình quân2
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Khái niệm chung

• Dự đoán thống kê là xác định mức độ của hiện
tượng trong tương lai bằng cách sử dụng tài liệu
thống kê và áp dụng các phương pháp phù hợp

• Tài liệu thống kê thường được sử dụng trong dự
đoán thống kê là dãy số thời gian

1. Dự đoán dựa vào lượng tăng (giảm) 
tuyệt đối bình quân

• Công thức: hyy nhn .ˆ 

111
12















n

yy

nn
nn

n

i
i



Trong đó:

Lượng tăng (giảm) tuyệt đối bình
quân

Điều kiện áp dụng: Dãy số có các lượng tăng (giảm) 
tuyệt đối liên hoàn xấp xỉ nhau
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2. Dự đoán dựa vào tốc độ phát triển
bình quân

• Công thức: h
nhn tyy )(ˆ 

Trong đó:

Tốc độ phát triển bình quân

Điều kiện áp dụng: Dãy số có các tốc độ phát triển
liên hoàn xấp xỉ nhau

1

1

11

2





  n nn
nn

n

i
i y

yTtt

3. Dự đoán dựa vào hàm xu thế

)(ˆ ii tfy • Mô hình dự đoán:
Trong đó:
ti: thứ tự thời gian
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I

NHỮNG VẤN ĐỀ 
CHUNG VỀ 

PHƯƠNG PHÁP 
CHỈ SỐ

II

PHƯƠNG PHÁP 
TÍNH CHỈ SỐ

III

HỆ THỐNG
CHỈ SỐ

CHƯƠNG VIII: PHƯƠNG PHÁP CHỈ SỐ

I Những vấn đề chung về phương pháp chỉ số

Khái niệm1

Các loại chỉ số2

Đặc điểm3
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1 Khái niệm 

Chỉ số là số tương đối (tính bằng lần hoặc %) biểu
hiện quan hệ so sánh giữa hai mức độ của cùng một
hiện tượng nghiên cứu

Chỉ số trong thống kê là phương pháp biểu hiện quan
hệ so sánh giữa hai mức độ cùng loại

2 Phân loại

CHỈ SỐ

Theo đặc điểm 
quan hệ thiết lập

Theo phạm vi Theo nội dung 
chỉ tiêu

Chỉ số 
phát 
triển

Chỉ số
không
gian

Chỉ số
kế

hoạch

Chỉ số 
đơn (cá 

thể)

Chỉ số 
tổng 
hợp 

(chung)

Chỉ số chỉ 
tiêu chất 
lượng

Chỉ số chỉ 
tiêu số 
lượng
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3. Đặc điểm của phương pháp chỉ số

- Khi phản ánh sự biến động của hiện tượng gồm
nhiều phần tử -> chuyển chúng về dạng giống nhau
để có thể trực tiếp so sánh được với nhau

- Khi có nhiều nhân tố tham gia vào tính toán thì giả
định chỉ có một nhân tố nghiên cứu thay đổi còn các
nhân tố khác cố định (không thay đổi)

II Phương pháp tính chỉ số

Chỉ số phát triển 1

Chỉ số không gian2

Chỉ số kế hoạch3
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1 Chỉ số phát triển 

Chỉ số đơn

Chỉ số tổng hợp

1.1 Chỉ số đơn

 Chỉ số đơn của chỉ tiêu chất lượng (lấy giá bán
làm ví dụ):

)100(
o

1
p p

p
i 

)100(
o

1
q q

q
i 

 Chỉ số đơn của chỉ tiêu số lượng (lấy lượng
hàng tiêu thụ làm ví dụ):
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1.2 Chỉ số tổng hợp

Chỉ số tổng hợp của chỉ tiêu chất lượng (lấy giá 
làm ví dụ):




qp

qp
I

o

1
p

1.2 Chỉ số tổng hợp




oo

o1L
p qp

qp
I





















oo

o0
op

oo

o0p

oo

o0
0

1

oo

o1L
p qp

qp
.di

qp

q.pi

qp

qp
p

p

qp

qp
I 0dđótrong

– Chỉ số tổng hợp của Laspeyres (quyền số ở kỳ gốc)

- Biến đổi theo chỉ số đơn về giá: ip
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1.2 Chỉ số tổng hợp

- Chỉ số tổng hợp của Paasche (quyền số ở kỳ 
nghiên cứu) 




1o

11p
p qp

qp
I

























11

11
1

p

1

p11

11

p

11

11

11
1

o

11

1o

11P
p qp

qp:

i
d

1

.iqp
qp

1

i
qp
qp

qp
p
p

qp
qp
qp

I dtrđ

- Biến đổi theo chỉ số đơn về giá: ip

1.2 Chỉ số tổng hợp

- Chỉ số tổng hợp của Fisher (khi có sự chênh lệch 
lớn giữa chỉ số của Laspayres và Passche) 







1o

11

0o

01F
p qp

qp

qp

qp
I .. P

p
L
p II
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1.2 Chỉ số tổng hợp

Chỉ số tổng hợp của chỉ tiêu số lượng (lấy 
lượng làm ví dụ):




0

1
q pq

pq
I

1.2 Chỉ số tổng hợp




oo

10L
q qp

qp
I








  oq

oo

o0q

oo

o0
0

1

oo

10L
q .di

qp
q.pi

qp

qp
q
q

qp
qp

I

- Chỉ số tổng hợp của Laspeyres (quyền số ở kỳ gốc)

- Biến đổi theo chỉ số đơn về lượng: iq
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1.2 Chỉ số tổng hợp

- Chỉ số tổng hợp của Paasche (quyền số ở kỳ 
nghiên cứu) 




01

11p
q qp

qp
I








 





q

1

q11

11

q

11

11

11
1

o

11

01

11P
q

i
d

1

.iqp
qp

1

i
qp
qp

qp
q
q

qp
qp
qp

I

- Biến đổi theo chỉ số đơn về lượng: iq

1.2 Chỉ số tổng hợp

- Chỉ số tổng hợp của Fisher (khi có sự chênh lệch 
lớn giữa chỉ số của Laspayres và Passche) 







01

11

0o

10F
q qp

qp

qp

qp
I .. P

q
L
q II
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2 Chỉ số không gian 

Chỉ số đơn

Chỉ số tổng hợp

Bài toán tổng quát

 Giả sử nghiên cứu biến động về giá bán và khối lượng 
tiêu thụ của các mặt hàng ở hai thị trường A và B

 Ký hiệu:
p - giá bán
q - lượng hàng tiêu thụ
A, B – Thị trường A, B
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Chỉ số đơn
Chỉ số đơn về giá

(B/A) p
(A/B) p i

1i 
B

A

p
p

(B/A) q
(A/B) q i

1i 
B

A

q
q

 Chỉ số đơn về lượng

Chỉ số tổng hợp

 Chỉ số tổng hợp về giá




qp
qp

B

A
(A/B) pI

BA
B

A

BAB

BAA qqQđóTrong
Qp
Qp

qqp
qqp













)(
)(

I (A/B) p
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Chỉ số tổng hợp

Chỉ số tổng hợp về lượng




B

A

qp
qp

(A/B) qI




B

A

qp
qp

(A/B) qI
BA

BBAA

qq

qpqp
p




víi

- Lấy giá do cố định (pn) do nhà nước quy định)




Bn

An

qp
qp

(A/B) qI

- Lấy giá trung bình của hai thị trường

2.3. Chỉ số kế hoạch

• Nếu căn cứ vào sản lượng thực tế của 
doanh nghiệp ở các kỳ, ta có 2 loại chỉ số:

+ Chỉ số kế hoạch giá thành:




0

0

qz

qz
I

o

k
z




1

11

qz

qz
I

k
z

+ Chỉ số thực hiện kế hoạch giá thành:
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2.3 Chỉ số kế hoạch

• Nếu căn cứ vào sản lượng kế hoạch của 
doanh nghiệp:

+ Chỉ số kế hoạch giá thành:




ko

kk
z qz

qz
I




kk

k
z qz

qz
I 1

+ Chỉ số thực hiện kế hoạch giá thành:

III Hệ thống chỉ số

Khái niệm chung về hệ thống chỉ số1

Phương pháp xây dựng hệ thống chỉ số tổng hợp 2
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Khái niệm 

• Hệ thống chỉ số là một dãy các chỉ số có liên hệ với
nhau, hợp thành một phương trình cân bằng

• Ví dụ:

Cấu thành của một hệ thống chỉ số thường bao gồm
một chỉ số toàn bộ và các chỉ số nhân tố

IqIpIpq 

Tác dụng 

Phân tích biến động (tuyệt đối, tương đối) của

hiện tượng do ảnh hưởng biến động của các

nhân tố.

 Tính ra 1 chỉ số chưa biết khi đã biết các chỉ

số còn lại trong hệ thống
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 Quy tắc xây dựng 

 Sắp xếp các nhân tố theo trình tự tính chất lượng

giảm dần, tính số lượng tăng dần

 Khi phân tích sự biến động của nhân tố chất lượng

sử dụng quyền số là nhân tố số lượng ở kỳ nghiên

cứu, khi phân tích sự biến động của nhân tố số lượng,

sử dụng quyền số là nhân tố chất lượng ở kỳ gốc

2. Hệ thống chỉ số tổng hợp

Biến động tương đối:
Ipq = Ip x Iq








 

00

10

10

11

00

11

qp
qp

x
qp
qp

qp
qp

          001010110011 qpqpqpqpqpqp
qp

pq pqpq


 Biến động tuyệt đối:

Vận dụng phân tích sự biến động doanh thu do ảnh
hưởng biến động của giá và lượng
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